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Prinergy Evo 4.0 Release Notes

Introduction 
We are pleased to send you the latest version of the Kodak® Prinergy® Evo™ 
software. These release notes highlight the changes and improvements that were 
made to release 4.0 of the Prinergy Evo software. Where appropriate, they refer you 
to the Prinergy Evo documentation set for more information. 

Prinergy Evo 4.0 Server software runs on Microsoft® Windows® 2000 Professional 
operating system, Windows 2000 Server® operating system, or Windows Server 
2003 operating system. Prinergy Evo 4.0 Client software runs on Windows 2000, 
Windows 2000 Server, Windows Server 2003, and Windows XP Professional 
operating systems, and on Apple® Mac OS® X 10.3.9 or later. 

Upgrading and License Keys
When upgrading from Prinergy Evo 1.0–1.2 or 3.x, we require that you replace the 
older Prinergy Evo license key with a new Prinergy Evo 4.0 license key. 

If you have a full-support plan, license keys are automatically generated for you. You 
can access the key using the new Get Keys button on the License tab of Prinergy Evo 
Administrator if you have Prinergy Evo 1.2 or later. 

If no key was posted for you but you require one, or if you are unable to use Prinergy 
Evo Administrator to access updates and have received the Prinergy Evo 4.0 
installer in another way, you can manually order a new Prinergy Evo license key. 

To manually order a new license key: 

1. On the Prinergy Evo server computer, start Prinergy Evo Administrator. 

2. On the License tab, click View keys. 

3. In the Prinergy Evo License Manager dialog box, click Dongle ID. 

4. From the Dongle Security Code dialog box, write down the first five digits of the 
dongle identification number. 

Contact your Kodak service representative, provide the dongle identification 
number, and request a new Prinergy Evo license key.

Note:  If you have a full-support plan or your Prinergy Evo system is still under warranty, 
software upgrades are included as part of your support plan entitlement. Accordingly, 
if you upgrade from Prinergy Evo 1.0–1.2 or 3.x, the Prinergy Evo 4.0 software is part of 
your entitlement. If your Prinergy Evo server computer has access to the Internet, the 
Prinergy Evo 4.0 upgrade can be accessed and downloaded by clicking Check Now on 
the Updates tab of the Prinergy Evo Administrator. As a full-support plan customer, you 
can access your pregenerated license key by clicking Get keys on the License tab.
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If you don't have a full-support plan or are no longer under warranty, the upgrade to 
Prinergy Evo 4.0 software is chargeable. If your Prinergy Evo server computer has 
access to the Internet, the Prinergy Evo 4.0 upgrade can still be accessed and 
downloaded by clicking Check Now on the Updates tab of the Prinergy Evo 
Administrator. For pricing information and to receive your upgrade license key, please 
call your local support center.

What Is in These Release Notes
These release notes include the following sections:

• What’s New

• Enhancements describes improvements that were made to existing features.

• Problems Fixed lists problems in previous releases of the Prinergy Evo software 
that are now resolved.

• Known Problems lists problems that are not yet resolved.

• Adobe Software Components in Prinergy Evo lists the Adobe® software 
component versions.

What’s New

Font Outlining
Font Outlining, a previously licensed option, is now included in the base license for 
Prinergy Evo 4.0 software. Font Outlining is an option in vector output which causes 
all text objects on the page to be replaced with vector outlines, and all font 
references on the page to be removed. This removes the dependency on the font 
resource to prevent downstream editing, and to enable the file to be more 
transportable.

Native Support for Transparent Objects Throughout the Workflow
Prinergy Evo 4.0 now enables you to easily process transparencies without 
flattening them, providing simpler, faster, and more accurate color matching and 
trapping of files with transparent objects. PDF processing engines like Color 
Matcher and Trapper features have been upgraded to handle transparent objects 
natively, eliminating artifacts that sometimes could be introduced as a result of 
flattening.

With the release of Adobe PDF 1.4 and Adobe Creative Suite 2, graphic designers 
could easily apply transparency effects to vector artwork, creating translucent 
shapes, text, drop shadows, and masks. When you write a PDF 1.4 file and later from 
Illustrator® 9 and later, and Adobe InDesign® 2 and later, the file may contain 
transparent objects. 
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Before Prinergy Evo 4.0, transparent objects in PDF 1.4 and later files had to be 
flattened to PDF 1.3 objects during the normalizing process, sometimes with 
unpredictable results. To take advantage of Prinergy Evo's transparency handling, 
you need to ensure your incoming files contain native (unflattened) transparency. To 
do this out of Illustrator or InDesign, export the file to PDF 1.4 or later. Do not print 
the file to PostScript or to a PDF file.

Preserving transparent objects during the refine process allows users to take 
advantage of newer technologies such as the Adobe PDF Print Engine.

New RIP: Adobe PDF Print Engine
Prinergy Evo 4.0 includes the Adobe PDF Print Engine, a new PDF RIP from Adobe 
Systems Inc. The Adobe PDF Print Engine allows PDF files to be rendered natively, 
using similar technology that is in Adobe Acrobat® and Adobe Creative Suite 
software. This ensures that complex designs and effects, including transparencies, 
are rendered quickly and reliably.

With Prinergy Evo 4.0, you can now use either the Adobe PDF Print Engine or CPSI 
RIP by selecting the RIP option in the process template.

Kodak encourages you to try the Adobe PDF Print Engine, a powerful new tool that 
is the industry’s most advanced PDF printing platform.

The Adobe PDF Print Engine provides the following advantages over the CPSI RIP:

• The Adobe PDF Print Engine accurately handles files with native transparency 
without flattening. If a file exposes a problem in the flattener or in the CPSI RIP, 
the Adobe PDF Print Engine can handle the file correctly.

• The Adobe PDF Print Engine’s rendering of fonts is more like the rendering of 
fonts in Acrobat.

• The Adobe PDF Print Engine correctly renders text that is located below 
transparent images. Occasionally, when the CPSI RIP renders low-resolution 
proofs, the text appears fatter due to the flattening that occurs in CPSI. Because 
the Adobe PDF Print Engine does not flatten, it does not have this problem.

When using the Adobe PDF Print Engine, consider the following:

• The Adobe PDF Print Engine cannot process PDF files containing embedded 
Adobe PostScript® objects. 

• In some cases, the CPSI RIP processes copydot data more quickly than the 
Adobe PDF Print Engine.

• The Adobe PDF Print Engine does not currently support Kodak DotShop™ 
screening information.

• It's still a new technology that has not been used as extensively as the CPSI RIP.

• Kodak recommends using the same RIP for outputting to proofs and plates. 
Because the CPSI RIP and the Adobe PDF Print Engine are based on different 
technologies, the final output may vary.
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Prinergy Evo Provides Native Support For Macs With Intel Processors
Prinergy Evo Client software provides Universal Binary support for all Macintosh 
computers with the new Intel® processors. Apple announced that it plans to 
transition all of its Macintosh computers to Intel processors by the end of 2007. 
Earlier versions of Macintosh computers used processors manufactured by 
Motorola.

New Setting Permits Multiple Copies for Proofing and Plating 
Prinergy Evo 4.0 includes a change to the Process Template Editor so that you can 
output multiple copies for proofing and plating. Use the Number of Copies box to 
output multiple proofs when you select an output device in the Output To list or any 
kind of file format with a destination path that points to a printer. You may want to 
use this feature for large jobs that require more impressions than the plate’s life 
expectancy, or when you require a double hit of ink.

The Number of Copies box is in the Device section of the output from PDF, 
imposition, PostScript, and TIFF process templates.

New Dynamic Process Template Settings
Prinergy Evo 4.0 includes two new settings in the Process Start dialog box that 
enable you to make process template setting changes on the fly before the process 
is executed. All changes for these settings are temporary and only affect the files 
about to be processed. This gives you the flexibility to make processing decisions 
without the need to create a new process template.

Make Last-Minute Changes to Media Using the Configuration List
When you drag one or more input files to an output from PostScript, PDF, 
imposition, and TIFF process template icon in the Template Browser or template 
palette, Prinergy Evo software displays the Process Start dialog box. If you click 
Settings and then Media in the Process Template Settings dialog box, Prinergy Evo 
displays a new Configuration list, which displays the media type, the media 
dimensions, the ink type, paper, and resolution, depending on whether you output to 
plating devices or proofers. The system may also display information about the 
media’s maximum and minimum dimensions, whether the media is rollfed or cut 
sheet, as well as details about the size of the paper, margins, and gutters.

Select Imposition Devices Dynamically
When you drag one or more input files to a create imposition process template icon 
in Prinergy Evo’s Template Browser or template palette and click Settings, there’s a 
new Device list in the Imposition area. Use the Device list to select an imposition 
device on the fly. You can also assign different output devices for different signatures 
that you've selected in the dialog box. For example, for a book you may want to 
select one device to print the 4-up cover pages and another device to print the 8-up 
inside pages.
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Support For Recognizing 1-Bit TIFF File Sets
Prinergy Evo 4.0 recognizes all the 1-bit TIFF files that belong to one job. When you 
submit a master file with a group of 1-bit TIFF files, Prinergy Evo 4.0 gathers 
additional details about all the input files that should be included in one job. This 
master file with a group of 1-bit TIFF files, officially known as AIT (Approval Interface 
Toolkit) proofing parameter files, are created by Kodak Prinergy software and third-
party workflows.

Importing and Exporting Multiple Process and Workflow Templates
To make it easier to transfer process templates and workflow templates to one or 
more Prinergy Evo systems, you can now import and export multiple templates. Use 
the Prinergy Evo Administrator software to import and export all of the process and 
workflow templates on your system; use the Process Template Editor to import and 
export one or more process templates that you select.

TIFF Annotation
Prinergy Evo 4.0 provides you with the ability to annotate TIFF files at output so you 
can include print details such as the date, the name of the job, and plate ID. This 
feature supports all variable marks. Use the Slugline Mark box in the output from 
TIFF process template to add the extra details. You can also control the placement 
of the slugline.

New Linearization Curve
Prinergy Evo 4.0 includes the ability to use two curves for calibration so that you can 
separate media linearization from press calibration. This feature also allows you to 
apply only one calibration curve, to support calibration methods used in earlier 
versions of Prinergy Evo.

Here’s how you could use the two curves:

First, using a plate dot reader, measure the linearization of your plate. Create a 
linearization curve in Kodak Harmony® tonal calibration software. In Prinergy Evo, 
select a Plate Curve to linearize your plate (or compensate for non-linear plates or 
devices).

Second, using a densitometer, measure the accuracy and consistency of the printed 
output. If necessary, select a Print Curve (Calibration) to achieve the desired 
density on press.

Both curves are located in the Calibration & Screening section of the output from 
imposition, PDF, and PostScript process templates.
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Kodak Prinergy Virtual Proofing System 3.0 Software
Kodak Prinergy® Virtual Proofing System (VPS) 3.0 software is delivered with 
Prinergy Evo 4.0. Prinergy VPS 3.0 software provides the following new features:

Rotating an Image Either Left or Right
You can now rotate an image to the left or right using the Rotate Left or Rotate Right    
icons in the toolbar. This is helpful when you view jobs that are set to use optimum 
space. As well, you can now set your Preferences so that when a job is opened, the 
image is automatically rotated into an upright position.

Densitometer Tool
The densitometer tool measures the ink density at any given point or over any given 
region. Draw a marquee with this tool and ink density readings for the corresponding 
pixels of the given rectangular area display in the Separations Palette. Just click 
outside the marquee and the Densitometer returns to measuring the ink density of 
individual pixels again. 

Ink Coverage Dialog Box
The feature displays the percentages of ink coverage that will be required per press 
sheet. 

Type Safety Edges
The Type Safety Edges feature allows you to change the color of the bounding box 
that surrounds the image.

Improvements to Prinergy Evo TIFF Downloader
Prinergy Evo 4.0 TIFF Downloader includes a number of improvements so that you 
can easily change the priority of items in the View by Queue in the Process Viewer.

Online Tutorials Readily Available
Prinergy Evo 4.0 includes a number of animated tutorials that explain how to use key 
features of the software, including:

• Create Imposition

• Signature Booklet

• Preflight Editor

• Workflows

• Queue Management

• TIFF Downloader

All of these tutorials are available in English, French, Italian, German, Spanish, 
Simplified Chinese, and Japanese except TIFF Downloader and Queue 
Management. 
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To view the tutorials:

1. In the Process Viewer, select Help > Prinergy Evo Help.

2. In the online help, click Index.

3. In the keyword box, type tutorials.

4. In the list of entries below, click tutorials.

The help displays the “Show Me Demonstrations” help topic.

To view the tutorials, Adobe Flash Player must be installed. If it’s not already 

installed on your computer, you can install the free download directly from the 

http://www.adobe.com/products/flashplayer/ web site.
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Enhancements
• Prinergy Evo 4.0 increases the amount of time the software will wait for CT/LW 

file sets, to compensate for the length of time that it may take to copy large files 
over a network. (PR: SCHN-J-0000157)

• Prinergy Evo includes new Hot Folder controls in the Data Retention dialog box. 
The Never delete input files and Delete input files after __ hours give you 
simplified controls over how the software deals with input files that are 
submitted to hot folders. (PR: JGAT-J-0000629)

• When viewing an active workflow window, you can now use the arrow keys on 
your keyboard to move between workflow steps. (PR: JGAT-J-0000576)

• In Prinergy Evo 4.0, you can now add a number up to three decimal places in the 
Scale boxes in the Layout section of the Process Template Editor. Previously, 
Prinergy Evo only supported numbers with one decimal place. (PR: JGAT-J-

0000718)

• In Prinergy Evo 4.0, support has been added for 16-bit images, submitted 
directly or embedded in submitted input files. OPI does not support 16-bit 
images, so the images must be submitted directly or embedded. (PR: SCHN-J-

0000175)

• When you open files in Prinergy VPS 3.0, the software starts at the folder that 
you most recently used. Earlier versions of the software would start at an 
arbitrary location. (PR: JCOX-J-0000470) 

• Prinergy Evo 4.0 provides new placement settings in the output from TIFF and 
output from imposition process templates. These settings provide you with 
more control over how the software positions layouts on the media. The controls 
have been available in the output from PDF process template for some time. (PR: 

JGAT-J-0000431)

• Prinergy Evo now warns you that specific selections may cause problems during 
output. The software displays a warning when you configure the Render section 
to make 1-bit output and you select one of the following:

Match Colors in an output from PDF or imposition process template.

Convert to process (in the output from PDF process template) or Convert 
separations to process (in the output from imposition process template) in 
the Spot Color Handling list in the Render section. (PR: JGAT-J-0000762)

• Prinergy Evo includes a change to the View by Queue in that the Information 
column is now displayed first under the Queued Items list. This makes it easier 
to see the name of each individual TIFF, instead of the process the TIFF file is 
associated with. (PR: JGAT-J-0000830)

• A pop-up window in the status area of the desktop now periodically reminds 
users to consider saving their Prinergy Evo configuration if a week has passed 
since the last time the configuration was saved. (PR: JGAT-J-0000785)

• For a workflow template, the Schedule by Time control step has been simplified 
so it easier to specify start times for recurring events. (for example, Sunday at 10 
a.m.) In addition, you can choose how long the software will hold subsequent 
input files it collects (for example, after the initial time, the software releases 
input files every two hours). (PR: JGAT-J-0000363)
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• Prinergy Evo 4.0 uses Adobe Acrobat software versions 7.0 and 8.0.

• The Kodak Prinergy Geometry Editor® software plug-in for Acrobat version 7.0 
and 8.0 has been updated, so that you can visually set the trim, media, crop, art, 
or bleed boxes for one or more files.

• You can now choose a right-binding style for the Signature Booklet feature in the 
Process Template Editor and in dynamic settings. The controls in the software 
have been renamed to Document Binding (formerly Document Folding Style). 
(PR: JCOX-J-0000382)

• In the output from TIFF process template, you can now set file format settings 
for all file types that output from TIFF can generate. (PR: JGAT-J-0000583) 

• In the Layout section of the process templates, the Shift settings are now 
available when you select Center in the Alignment lists. (PR: JGAT-J-0000797)

• Kodak Staccato® screens have been revised to subdue visible patterns, non-
uniformities, and to improve the average quality of printed results. Specific 
quality issues with 35 micron Staccato have also been addressed, making it 
suitable for a wider range of applications. The 36 micron Staccato has been 
modified with uniform highlight dots that are more suitable to cold-set web 
press applications and other newsprint presswork. (PR: JGAT-J-0000861)

• In the View by Queue in the Process Viewer, you can change the priority of items 
in the queue using right-click (Windows) or control-click (Macintosh). (PR: 

JCOX-J-0000483)

• New placement settings in the output from imposition process templates allow 
you to place the imposition more precisely on the media. The new alignment 
controls allow you to set reference edges, (Left, Right, Top, and Bottom) in 
addition to centering horizontally and vertically, as in previous releases.

In Prinergy Evo 4.0, rotation is applied first, then the imposition is placed 
according to the alignment settings. In previous releases, when orientation was 
set to either autoclockwise or autocounterclockwise and you selected center 
horizontally, the axis for centering would change if the imposition sheet had to 
be rotated to fit the defined media. In effect, alignment was dependent on 
orientation. 

If, for example, rotation was required to fit the imposition to media, it would 
change from bottom-center to center-left. If you are using auto rotate and 
centering in output from imposition process templates, ensure that you review 
the new placement settings in Prinergy Evo 4.0.
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Problems Fixed
• When you backed up your system using the Prinergy Evo Administrator 

software, the backup sometimes failed due to bad characters in file names or 
paths (for example, / \ : # $ % ! + { } [ ] , ; • &). In Prinergy Evo 4.0, the software 
skips Mac OS X resource forks and files it cannot back up. Files that are skipped 
are recorded in Prinergy Evo's log files. (PR: JGAT-J-0000680)

• The Advanced Preflight section of Process Template Editor includes new default 
settings so that the system alerts you if it detects any warnings and fails if it 
encounters any errors. Before Prinergy Evo 4.0, the default settings were set to 
treat all warnings and errors as informational. (PR: JGAT-J-0000685)

• When you added a PDF file to a create imposition process template with the 
Binding Style list set to Flatwork and clicked Settings in the Process Start dialog 
box, Prinergy Evo incorrectly displayed a set of Saddle Stitch templates in the 
Process Template Settings dialog box. (PR: EYAU-J-0000259)

• In previous versions of Prinergy Evo, the full ICC profile color space was not 
considered when colorants were selected for output. Prinergy Evo now always 
considers the color space of any ICC profile applied to the process template 
when Match Colors is used. (PRs: JGAT-J-0000608, JGAT-J-0000532, JGAT-J-0000739, 

IROS-J-0000025)

• Strokes around some type objects changed shape when refined in Prinergy Evo 
3.1 and 3.2. This behavior was due to a change in the Normalizer code and is 
related to changes in Adobe Acrobat Distiller 7, which displays the same 
behavior. (PR: JGAT-J-0000634)

• If you created an 8-bit TIFF file using Adobe Photoshop CS2, saved it with no 
compression, and then submitted it to a refine to PDF process template in an 
earlier version of Prinergy Evo, the file sometimes failed to refine with a vague 
error message. (PR: SCHN-J-0000178)

• In earlier versions of Prinergy Evo, when you chose Edit > Find in the Process 
Viewer on a Macintosh client, the client software stopped working. (PR: JGAT-J-

0000716).

• In the past, when you updated versions of Prinergy Evo the software installer 
would request your username and password. This sometimes caused users to 
enter different account names than they were using earlier. The installer now 
disables the ability to change the username, and only requests that the 
password be entered for that account. (PR: JGAT-J-0000444)

• When using dynamic settings to create a custom imposition, the arrow buttons 
that allow you to reorder your signatures were not available. (PR: TMOS-J-0000028)

• When refining, there were some cases in which temporary files were being 
locked by the system and this caused the process to fail. (PR: GSCR-J-0000479)

• If you installed the Prinergy Evo Client software on a Prinergy Evo server 
computer, the installer software did not add the Prinergy VPS software and the 
Adobe Acrobat plug-ins. (PR: JCOX-J-0000276)

• When you use the Kodak Geometry Editor to adjust the Media Box for a PDF file 
and then save the file, the editor now properly saves the position of the Media 
Box to 0,0. (PR: JGAT-J-0000678)



 

Prinergy Evo 4.0 Release Notes 11

• Surfaces sometimes appeared in the wrong order when outputting multiple 
sheet signatures on servers running multiple printer Job Ticket Processors 
(JTPs). This has been corrected by prioritizing processes rather than tasks. (PR: 

JGAT-J-0000714)

• The Override all Screening option in the Calibration and Screening section of a 
process template overrode all screening information only for the first page of a 
multi-page Adobe PostScript file. Prinergy Evo 4.0 now overrides all screening 
information for all pages within a multi-page PostScript file. (PR: PSMH-J-0000028)

• Spread splitting (an option in the refine to PDF process template) caused page 
geometry information to change so that Vector PDF output appeared to be 
missing pages. (PR: JGAT-J-0000694)

• The signature booklet feature did not produce correct output when using 
impositions that contained single threads. It now properly deals with single-
threaded booklets (for example, books with a three-fold). (PR: JCOX-J-0000424)

• When flagged type was set as italicized, but used a non-italic font (that is, 
artificial italic type applied to the font), Prinergy Evo did not always trap the font 
correctly in spot color regions. (PR: JGAT-J-0000620)

• In an earlier version of Prinergy Evo, the batch trapper's “grouping by line” 
feature changed the way it grouped text compared with the previous version of 
Prinergy Evo. The trapper's text grouping (by line) feature has been restored to 
the correct behavior. (PR: JCOX-J-0000363)

• Dainippon Screen TIFF files were not correctly classified in Hold control steps 
within workflows. Prinergy Evo now identifies Dainippon Screen TIFF files 
properly so further processing may take place. (PR: JGAT-J-0000611)

• The PDF Preflight Profile engine displayed an error message regarding 
transparent objects within a file when it was only supposed to warn about 
transparent objects within the file. Within the Preflight profile, the engine now 
respects the directive to warn and does not display an error message, unless 
necessary. (PR: ETKH-J-0000204)

• In previous versions of Prinergy Evo, if multiple items were selected in an output 
queue in the View by Queue view and the hold status of the items was toggled, 
the items would reorder in a random manner. (PR: JGAT-J-0000787)

• In previous versions of Prinergy Evo, the Macintosh Client software did not allow 
you to change the priority of a process using right-click. (PR: IROS-J-0000040)

• In an earlier version of Prinergy Evo, Photoshop TIFF files were incorrectly 
classified when submitted to refine. (PR: JGAT-J-0000767)

• Some EPS files from Motoya Prox Elwin v9 failed to refine in previous versions of 
Prinergy Evo. (PR: JGAT-J-0000751)

• Some grayscale vector type would disappear after being refined in earlier 
versions of Prinergy Evo. (PR: JGAT-J-0000748)

• In previous versions of Prinergy Evo, scaling settings from imposition files were 
honored only from PJTF files. Prinergy Evo now supports imposition scaling 
defined in JDFs. (PR: SCHN-J-0000168)
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• In Prinergy Evo 3.2.6.0, the Adobe Acrobat® 7 plug-in help files did not properly 
open when you attempted to select them from the Help menu in Acrobat. (PR: 

JGAT-J-0000773)

• In Prinergy Evo 3.2.6.0, some labels contained extra text or were misaligned in 
the Process Template Editor. (PR: JGAT-J-0000760)

• If you selected an output from imposition process step inside an active workflow 
window, Prinergy Evo sometimes displayed the list of signatures out of order in 
the Created Files list. (PR: JGAT-J-0000745)

• Using the output from imposition process template, all screen angles that were 
less than 90 degrees sometimes incorrectly displayed values (that is, 180 
degrees off) in the Process Template Editor and in variable marks. (PR: JCOX-J-

0000515)

• When you outputted multiple TIFF files and changed the order of the files in the 
View by Queue and paused and resumed files, Prinergy Evo sometimes did not 
process the files. (PR: JGAT-J-0000832)

• When you selected File > Refine Files to PDF in the Process Viewer and browsed 
to a location with TIFF files, the TIFFs would not appear in the Select Input Files 
dialog box. To see the files you needed, you needed to select All Files in the Files 
of Type list. (PR: JGAT-J-0000590)

• On the Windows client, you can change which columns are visible in the Process 
Viewer. When you restart Prinergy Evo, the software now displays the same 
columns that you specified. (PR: JGAT-J-0000509)

• If you opened the Advanced Trap Editor on a Macintosh computer, the editor 
would sometimes be unable to connect to the license server. (PR: PNGN-J-

0000174)

• When you selected Settings in the Process Start dialog box, the Calibration 
curves selected did not take effect with IS screening. (PR: SZMA-J-0000022)

• In earlier versions of Prinergy Evo, if Print Console lost communications with an 
output device, Prinergy Evo failed all the files in the queue. Now, if this scenario 
occurs, only the active files fail and the other queued files sit in the same order 
until processing can resume. (PR: JCOX-J-0000484)

• When you output to PDF Raster using the output from TIFF process template, 
Prinergy Evo now disables the Scaling functionality in the Layout section. In 
earlier versions of Prinergy Evo, you could select Scale Horizontally in the 
process template but the software did not scale. (PR: IROS-J-0000017)

• When you submitted an input file to an output from PDF or imposition process 
template, clicked Settings in the Process Start dialog box, and selected
Do not output for most colors but mapped one spot color to another color, the 
software erroneously outputted all colors. (PR: JGAT-J-0000725)

• In some cases if a direct connect output device was disconnected, the status of 
the device was not correctly updated in the Device Information dialog box in the 
Process Viewer. (PR: KCHN-J-0000364)

• In previous versions of Prinergy Evo, the View by Queue view did not always 
update correctly when adjusted. The window now correctly refreshes when it is 
changed. (PR: ETKH-J-0000508)
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• In some cases in Prinergy Evo 4.0.4.0, the create imposition process would fail 
consistently. (PR: JGAT-J-0000820)

• Some PDF 1.4 files exported from Adobe InDesign failed in the Adobe PDF Print 
Engine due to special characters in the file path. Prinergy Evo now handles these 
files more reliably. (PR: JGAT-J-0000819)

• Output to Kodak Veris™ digital proofers should not allow you to specify margin 
sizes. In earlier versions of Prinergy Evo, the Process Template Editor would 
allow you to specify margins, which would be ignored. Prinergy Evo 4.0 now 
correctly prevents you from entering values for output to Veris. (PR: JGAT-J-

0000811)

• Attempting to perform a remake of a remake in which the original item had been 
deleted caused the Process Manager to fail. Prinergy Evo 4.0 now enforces that 
remakes must be made from original processes. (PR: JGAT-J-0000806)

• A new variable mark $[VMRResolution] has been added to allow output to 
display Variable Mainscan Resolution adjustment on output. (PR: JGAT-J-0000803)

• In the Layout Section of the Process Template Editor, the labels Portrait Device 
and Landscape Device were shortened to Portrait and Landscape because the 
orientation refers to the file being generated and not the actual device in indirect 
connect workflows (that is, TIFF workflows). (PR: JGAT-J-0000799)

• In previous versions of Prinergy Evo, custom file naming settings were not 
honored when outputting to a Kodak Veris digital proofer. In Prinergy Evo 4.0, 
these settings are now honored correctly. (PR: JCOX-J-0000499)

• Previous versions of Prinergy Evo generated the list of files in workflows. These 
files would refer to loose page output as Signature<#>. This made it difficult to 
know what pages were in each signature without opening the files in a viewer. 
This has been changed so that the generated file list uses names based on the 
input file names. (PR: JGAT-J-0000320)

• In previous versions of Prinergy Evo, the TIFF Downloader would unnecessarily 
expose entire negative plates, even though only the imaged area would need to 
be exposed. This caused the negative plates to take longer to image than 
required. This has been corrected so that only the portion of the plate that needs 
to be exposed is imaged. (PR: JGAT-J-0000502)

• The Factory Process Templates have been updated to fix some inconsistencies 
in earlier versions of the software and to take advantage of transparency 
handling in refine. (PR: JGAT-J-0000844)

• In some cases when you moved an item up in the View by Queue, items 
immediately after the item would output before the urgent item even though 
they showed below it in the queue. (PR: JCOX-J-0000531)

• The %processname% variable is now supported as a custom file naming 
variable for the Create Imposition process template. (PR: JCOX-J-0000513)

• Printing to an AppleTalk® virtual printer from Mac OS 9 would cause the virtual 
printer to stop working (PR: JGAT-J-0000789)

• The Color Mapping dialog box showed incorrect settings for some black + spot 
color-only files for output from PDF processes. The end result was that spot 
colors set to convert to process would fail to output. (PR: ADJC-J-000087)
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• In previous versions of Prinergy VPS 3.0 software, using the scroll wheel when 
interacting with the separations panel would cause the software to 
unexpectedly quit. (PR: TMOS-J-000030)

• In previous versions of Prinergy Evo the first signature in a multiple signature 
imposition would sometimes have both surfaces listed as Front in the list of 
surfaces in the Process Start dialog box. (PR: JGAT-J-0000717)

• In the beta version of Prinergy Evo 3.2, the Prinergy Evo Server software would 
unexpectedly “freeze” when the software was stopping. (PR: JGAT-J-0000710)

• The Color Database Editor dialog box is now called Color Definitions. This new 
name is consistent with the option name that appears in the Configure menu in 
the Process Viewer. (PR: GSCR-J-0000471) 

• When you used the create imposition process template and then selected Come 
and Go from the Binding style list in the Process Template Settings dialog box, 
Prinergy Evo displayed the wrong page number for subsequent signatures. (PR: 

EYAU-J-0000238) 

• When you localized your keyboard layout to use German on a Macintosh and 
you used Prinergy VPS 3.0, you could not zoom in to more closely to examine 
VPS files using the COMMAND – PLUS key combination. (PR: JGAT-J-0000790)

• If you localized your Prinergy Evo system to use Japanese and clicked the More 
Details hyperlink at the bottom of the Process Viewer, the Windows Client 
software (PrinergyEvo.exe) closed unexpectedly. (PR: IROS-J-0000045)

• When you submitted multiple files to a hot folder with a linked workflow 
template and one process failed and one succeeded, both files would be sent to 
the Input_Error folder (rather than just the file associated with the process that 
failed). Now only the failed file goes into the Input_Error folder. (PR: IROS-J-

0000042)

• A PostScript file with radial and axial shadings lost some of the shadings when 
RIPed to a Prinergy VPS file. The Normalizer was enhanced to identify and fix the 
incorrect PostScript file, which caused the problem. (PR: JGAT-J-0000777)

• An .eps test file containing a missing font caused Prinergy Evo to not write a 
large black X over the content in the generated PDF file, contrary to what was 
expected. This situation was corrected by modifying the Normalizer to take 
account of situations where a certain “end of file” PostScript command was 
incorrectly indicating the location of the end of the file. (PR: JGAT-J-0000774)

• A PDF file containing some Russian (Cyrillic) characters had some of the text 
characters turn to rectangular boxes when output if you had selected Convert 
Text to Paths in the Render section of the Process Template Editor. This was 
fixed by updating the PDF Library. (PR: IROS-J-0000036)

• TIFF/IT files created by an ORIS RIP were not recognized by Prinergy Evo due to 
a restriction in the types of files that Prinergy Evo recognized as valid. In Prinergy 
Evo 4.0, ORIS TIFF/IT files can be processed. (PR: JGAT-J-0000693) 

• When users dynamically changed the settings of a create imposition process 
template by clicking Settings in the Process Start dialog box, Prinergy Evo could 
take up to a minute before opening the settings dialog box. This delay was 
caused by an inefficient algorithm used to read all of the Preps templates. (PR: 

IROS-J-0000028)
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• Files were sent to an incorrect location by output from PDF process templates 
when the templates were used in workflows and when virtual printers fed those 
templates. (PR: JGAT-J-0000675)

• The progress bar that indicated the status of output from PostScript processes 
never reached the end (signifying the completion of a process) even though the 
process had completed. (PR: KCHN-0000318) 

• Japanese language translations in the Process Template Editor were not visible 
in the File Delivery section of the output from imposition and output from 
PostScript process templates. (PR: JGAT-J-0000655) 

• Prinergy Evo TIFF Downloader could only use TIFF files that were less than 2 
gigabytes in size. Prinergy Evo TIFF Downloader can now use TIFF Files up to 4 
gigabytes in size (4 gigabytes is a Windows limitation). (PR: PSMH-J-0000025)

• The File Delivery process templates used in workflows did not deliver marks files 
with JDF imposition files. This has been corrected so that JDF mark file folders 
and the marks files are delivered with the JDF imposition file. (PR: JGAT-J-0000652)

• DCS master or control files with incorrect spaces in their file names could 
prevent a hot folder from recognizing the high resolution files associated with 
the master files. (PR: JGAT-J-0000625)

• Raster scaling sometimes incorrectly changed the outside boundaries of files 
when horizontal scaling was applied. (PR: IROS-J-000016)

• In earlier versions of the software, the Process Viewer displayed that “The CTP is 
offline” when connected to a version of Print Console system earlier than 4.8. 
(PR: PNGN-J-0000217)

• If a computer-to-plate (CTP) device was shut down or reset while imaging data, 
Prinergy Evo would not suspend the transmission of image data to the device. 
With Prinergy Evo 4.0, if a device is not capable of imaging, the software 
suspends the transmission of raster data. When the device is back online, 
Prinergy Evo detects the online status and resumes sending image data. (PR: 

IROS-J-0000051)

Known Problems
• If you try to install Prinergy Evo on the Windows Server 2003 operating system, 

the installer does not always run. The installation could fail if you start the 
Prinergy Evo installer from Windows Explorer. If you encounter this problem, 
drag the Prinergy Evo executable file to the command prompt and press ENTER 
on your keyboard. (PR: ETKH-J-0000459)

• The View Accelerator plug-in does not work with Acrobat 8.0 at this time. 
Acrobat 8.0 plug-ins are in beta.

• PDF files with transparent and overprinting objects in the same file will not be 
color managed even when the vector overprint feature is enabled. It is rare to 
find both transparent and overprint models used in the same PDF file. Generally, 
one will be used over the other and not at the same time in one file. Prinergy Evo 
will report a warning message when it encounters files of this type when 
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processing. To color manage these files, either set PDF Level Handling to Flatten 
to PDF 1.3 during refine, or use the raster color management option during 
output.

Adobe Software Components in Prinergy Evo
Prinergy Evo 4.0 includes the latest Adobe software components, including Nserver, 
PDF flattener, CPSI, and the Adobe PDF Print Engine. These software components 
include the latest fixes for outstanding errors.

The following table lists the Prinergy Evo 4.0 software components and the 
corresponding Adobe components.  

Prinergy Evo Component Adobe Component

Refining Nserver 7.05
Flattener 3017.102

Output CPSI 3017.102-08
Adobe PDF Print Engine 1_1_4001_1

CEPS Output CPSI 3017.102-08

PDF Library PDFL70.dll: 7.0.0.0
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